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Dingo Incident Report Form Insert Code: C Dingo ID:  OOR12m and untagged 

female 
 
Date (of incident):  08.02.2013 
Location (of incident): Eurong 

Time (of incident 24hrs): 0800 
Reporting Officer/s signature:  
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

             

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance) Coming within 2 
meters        

  damaging property (specify)       

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance)       

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify)       

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   

Sub adults 1 1       
Juvenile                   

Unknown Age                   

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: The male was tagged but the female 
was untagged 
 
d. Which ears were tagged Left 
    Details: Orange Orange Red  
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   tour participant      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people respond appropriately to the incident? (Ranger to assess) Yes 
Comments       
 

 
 

Detailed report of events: Brenton Smith and myself (John Green) were travelling south along the 
eastern beach turning into Eurong Resort when noticed OOR12m and untagged female were getting 
within 2 metres to a couple and their child who were taking photos. When we approached the couple to 
scare the dingo off and give a dingo briefing  the couple didn't care for what we had to say and 
proceeded to say they're not dangerous dogs. Once scaring the dingos off we returned to our vehicle 
and couple and their child return to the Resort. 
 

 

 

 

 

 

 

 

 

 

 

Additional comments and notes: Couple didn't responed in a positive way toward our dingo briefing 
but did comply with not encouraging the dingo to come closer and returned to the resort 
 

 

 

 

 

Action taken: Report generated and circulated  
 
 
 

 

 

Proposed further action:       
 
 

 

 

Faxed/emailed date:  08.02.2013                                 Officers signature:      
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Photos  
To add pictures, you will need to firstly unlock this form. Select the View Tab – then scroll down to Toolbar and 
select Forms. The Form toolbar will display – click the lock icon. You can now insert a picture using the Insert tab.   
 

         Photo 1. 
         Description (who took photo/when):
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

         Photo 2. 
         Description (who took photo/when): 
               

 

 

 

 

 

 

 

 

 

 

 

 

 

                               Photo 3. 
         Description (who took photo/when): 
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Dingo Incident Report Form Insert Code: C Dingo ID: OOR12m 

 
Date (of incident): 28.03.2013 
Location (of incident): Beach infront of Eurong 
Resort 

Time (of incident 24hrs): 1100am 
Reporting Officer/s signature:  
Base: Waddy Point 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

           

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance) within 1m of 
people        

  damaging property (specify)       

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance)       

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify) continued to loiter after being 
discouraged 

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   

Sub adults                   

Juvenile 1             

Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Flopped ear 
 
d. Which ears were tagged Left 
    Details: OOR12m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name: RBAC 
Address: Driver's unknown 
Phone #:       
Age:       
 
Name: (Witness) 
Address: Unique Fraser  
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Tag along tour      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people respond appropriately to the incident? (Ranger to assess) No 
Comments       
 

 
 

Detailed report of events: On Thursday 28.03.13 at approximately 11.00am six RBAC vehicles were 
parked outside the main entrance of the Eurong resort. While at this location a juvenile male dingo was 
seen loitering around. The dingo (OOR12m) walked casually in and out of the group within 1m of people. 

witnessed this and noticed that no one in the group were trying to 
discourage the dingo - then went over and actively discouraged the dingo from the group. 
 

 

 

 

 

 

 

 

 

 

 

Additional comments and notes:       

 

 

 

 

 

Action taken: Report generated and circulated 
 
 
 

 

 

Proposed further action: Continue to monitor this area. 
 
 

 

 

Faxed/emailed date:  2.4.2013                                 Officers signature:Anthony Dargusch 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the View Tab – then scroll down to Toolbar and 
select Forms. The Form toolbar will display – click the lock icon. You can now insert a picture using the Insert tab.   
 

         Photo 1. 
         Description (who took photo/when):
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

         Photo 2. 
         Description (who took photo/when): 
               

 

 

 

 

 

 

 

 

 

 

 

 

 

                               Photo 3. 
         Description (who took photo/when): 
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Dingo Incident Report Form Insert Code: C Dingo ID: Eurong 2012 juvs 

 
Date (of incident): 11/04/2013 
Location (of incident): Eurong beachfront resort 
entrance 

Time (of incident 24hrs): 12:30-13:00 
Reporting Officer/s signature: L. Behrendorff 
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

             

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance)              

  damaging property (specify)       

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance)       

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify) Not discouraged 

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     4 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   

Sub adults                   
Juvenile             4 

Unknown Age                   

 
c. Were the dingo(s) tagged click to select 
    Details: Observer recognised the juveniles from 
this area. 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name: RBAC Backpacker group from Rainbow 
beach 
Address: RBAC 
Phone #:       
Age:       
 
Details of person(s) reporting incident. 
Name from KBRV (driver) 
Address: C/- KBRV resort 
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Tag along tour      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people respond appropriately to the incident? (Ranger to assess) No 
Comments Tag-along clients are meant to receive all information regarding dingo safety prior to 
visiting Fraser Island as per permitting  conditions. 
 

 
 

Detailed report of events: KBRV) approached me at Central Station Wednesday 17th April and 
mentioned this feeding incident. As was with clients I caught up with him at Eurong resort Sat 20th 
and obtained the following details. 
 
He was conducting a tour on or around the 11th April where he observed a group of 20-25 tag-along 
clients (backpackers) with 4 parked vehicles surrounding 4 dingoes on the southern side of the resort 
entrance (This is where RBAC park their trailers). He mentioned that RBAC was written on the vehicles. 
He recognised the dingoes as the young resident Eurong dingoes. 
 

pulled his bus up to park for his tour to see the dingoes without exiting the bus approx 10 metres 
away from the RBAC group. From the bus he observed a number of the backpackers throwing chunks of 
food including bread rolls, ham and other items. He couldn’t see a noticeable tour leader amongst the 
group. If he had seen a leader he stated he would have spoken to them. 
 

had to leave for the luch break time schedule.  He has mentioned the incident to other tour drivers. 
 

 

 

Additional comments and notes: This is the second feeding incident reported by regarding 
feeding of these dingoes. has been encouraged to photograph future feeding incidents and contact 
QPWS to attend the scene if possible.  These dingoes are currently conducting code C behaviour and 
are regularly harassed by visitors and certain residents. 
 

 

 

Action taken: Incident reported encouraged to photograph feeding incidents where possible and 
contact a ranger to attend the scene. 
 

 

 

Proposed further action:  Continue education of visitors and tag along tours  focusing on the Eurong 
area. 
 
 RBAC tours are currently eating around the parked trailers on this beach entrance area on a regular 
basis, suggest requesting they move to another area where dingo/human interaction os less of an issue 
or eat in the Resort-council tabled areas within the fenced area. 
 
Some of the Eurong  dingoes have been observed sleeping under these trailers on a regular basis. 
 
 

 

 

Faxed/emailed date:  20 April 2013                                 Officers signature:  LB 
 
 
 
 
 

RTI D
L R

ELE
ASE - N

PSR

12-522 DL Documents 8 of 39

sch4p3( 3) Prejudice the protection of an individuals right to privacy



 1

Dingo Incident Report Form Insert Code: C Dingo ID: Orange Orange Red 

2012 Male & Unidentified male dingo 
 
Date (of incident): 20/5/13 
Location (of incident): Northern end of Wongai 
CZ 

Time (of incident 24hrs): Between 1230 and 1430 
Reporting Officer/s signature: John Dargusch 
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

             

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance)              

  damaging property (specify)       

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance)       

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify) When campers returned to 
their campsite. 

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   

Sub adults                   

Juvenile 1             

Unknown Age             1 

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: One 
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name:
Address: Southport 
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people respond appropriately to the incident? (Ranger to assess) Yes 
Comments       
 

 
 

Detailed report of events: On returning to their campsite at 1430 on the 20/05/13, and 
witnessed Two dingoes exit their tent and run off. found three different parts of their 

brand new tent that had been ripped by the dingo/es attempting to enter (See photos attached). He was 
adamant that the only thing inside their tent was their brand new mattress, which has been chewn by the 
dingoes. They were able to show me a photo of One of the dingoes that was taken shortly after it exited 
their tent which I positively identified as Orange Orange Red 2012 male. It is likely that the dingo with 
OOR12m was from a known pack in the area. 
 

 

 

 

 

 

 

 

 

 

 

Additional comments and notes: left a message on the dingo hotline at the Rainbow Beach 
info centre which was forwarded onto me shortly after the incident occurred by

 

Action taken: was briefed and was suggested to camp in a fenced camp ground as his tent 
was no longer secure. He agreed to move back to Central Station camp ground. Report generated and 
circulated 
 
 
 

 

 

Proposed further action: Explore possibilities of placing interpretative information (public notice?) in 
camp zones within the territory of dingoes that are known to carry out tent ripping behaviour. This 
information could highlight to visitors that dingoes that roam these particular CZ's are capable of carrying 
out this behaviour and that there is fenced camp grounds available for camping. 
 
 

 

 

Faxed/emailed date:  20/5/13                                 Officers signature:  John Dargusch 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the View Tab – then scroll down to Toolbar and 
select Forms. The Form toolbar will display – click the lock icon. You can now insert a picture using the Insert tab.   

         Photo 1. 
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         Photo 3. 
         Description (who took photo/when):
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Dingo Incident Report Form Insert Code: C Dingo ID: OOR12m, BPuP12f and 

RYRR07m?  
 
Date (of incident): 20/4/13 
Location (of incident): Govi CZ-sthn end 

Time (of incident 24hrs): 4:50 to 17:20 
Reporting Officer/s signature: L. Behrendorff 
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

             

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance)              

  damaging property (specify) Bags, toiletries. 
water bottle, book. 

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance)       

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify)       

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults 1             

Sub adults                   
Juvenile 1 1       

Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: As above 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:1 dingo larger than the others 
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
4 people in the group (1♂, 3♀) 
Name: 
Address: 
Phone #:       
Age:

Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people respond appropriately to the incident? (Ranger to assess) Yes 
Comments Campers are o'seas visitors with own vehicle. Bought permits at RB BP with 
brochures and obtained further information at the Manta Ray info office. They followed the 
brochure directions.  

 

Detailed report of events: A group of 4 travellers were finishing off dinner when 1 dingo approached 
them from the south towards the back of their van within 5 metres and waited. All 4 people got to their 
feet, folded their arms as directed by the brochure material. They noticed 2 more dingoes approaching 
from the other side. They came to within 3 metres. 
 
The group started calmly packing all the food items and associated crockery and pans away into the 
van. 
 
1 dingo approached to within 1-2 metres and backed off when the (tall male) moved. The females 
all got into the van. After got into the van the dingoes sniffed the table and chair areas. They 
chewed on the side of a chair, a water container and a book (Life of PI) that was taken from the seat.  
 
A dingo proceeded to the tent and chewed on the air matrice box, then entered the tent followed by 
another. Filming that occurred while the females were in the van was stopped at this stage as they 
wanted the phone to ring 13QGOV for assistance. 
 
13QGOV directed them to a ranger base number that went to message. 13QGOV was called again and 
directed them to police 13444. 2 of the dingoes jumped up (remaining on their back legs) to look into the 
van windows. 
 
The van horn was activated numerous times but did not deter the dingoes and a passing car was 
attracted but the occupant stopped, saw the scene from the vehicle and continued south without 
assisting. 
 
A sleeping bag and backpack had been removed from the tent. 
 
After the group noticed the tent wasn't moving anymore (20 mins passed) they got out and inspected the 
tent.  Large holes had been made in the rear where the dingoes got out and had left of their own accord. 
 
A toiletry bag with medication,  tampons, sandals and an air bed had been chewed on. 
 
The QPS officer on Fraser Island and a QPWS ranger met up with the group 8:40am  

 

 

Additional comments and notes: The video and photographs were supplied by the group. Rangers 
identified the dingoes. No aggressive behaviour was observed in the footage. 

 

 

Action taken: Incident reported and permission will be sought to obtain footage for educational 
purposes. Govi will be further monitored and briefing concentrated in that area. 
 

 

Proposed further action: Keep monitoring this area. This particular family pack is not currently of high 
concern but is being subjected to constant inference that may influence their behaviour. 

 

Faxed/emailed date:  21 April 2013                          Officers signature:  L. Behrendorff 
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Photos  
All photos taken by the group.  
Video footage being sent to QPWS - too big to download. 
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Dingo Incident Report Form Insert Code: C Dingo ID: OOR12m, PuWW12m & 

Unidentified 
 
Date (of incident): 3/04/2013 
Location (of incident): Govi CZ 

Time (of incident 24hrs): 10:00 
Reporting Officer/s signature:  
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

       Bait out of a bucket 

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance)              

  damaging property (specify)       

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance)       

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify)       

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   

Sub adults                   
Juvenile 2       1 

Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Two identified by dingo rangers 
 
d. Which ears were tagged Right  
    Details: Two male and one unidentified. 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people respond appropriately to the incident? (Ranger to assess) Yes 
Comments when the fishermen noticed the dingo stealing the bait from their bucket they locked it 
away in the car. 
 

 
 

Detailed report of events: On the 3rd April at approx 10:00 two fishermen on the beach outside Govi CZ 
were approached by three dingos. The dingos were coming within 1-2 meters proximity and showed no 
signs of aggression, fear or wariness. One of the dingos walked up to a bucket next to their car and stole 
a mullet. The fishermen quickly chased the dingos away and put the bucket in the car. An off duty dingo 
ranger travelling down the beach noticed the events and stopped and briefed them on dingo safety and 
food security.   

 

 

 

 

 

 

 

 

 

 

 

Additional comments and notes: The fishermen said the dingos went back up into the dunes and 
headed for their camp in Govi CZ. 

 

 

 

 

 

Action taken: The off duty ranger briefed the fishermen on dingo safety and food security. He also rang 
the Eurong dingo ranger who promptly went down and spoke to the fishermen. 
 
Rangers notified of the incident. Interview conducted by a dingo ranger and report generated and 
circulated. 
 
 
 

 

 

Proposed further action: Increase patrols and camp briefings within the area. 
 
 

 

 

Faxed/emailed date:  3/04/2013                                 Officers signature:  GM 
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Dingo Incident Report Form Insert Code: C Dingo ID: OOR12m, PuWW12m & 

Unidentified 
 
Date (of incident): 3/04/2013 
Location (of incident): Govi CZ 

Time (of incident 24hrs): 10:00 
Reporting Officer/s signature:  
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

       Bait out of a bucket 

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance)              

  damaging property (specify)       

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance)       

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify)       

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   

Sub adults                   
Juvenile 2       1 

Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Two identified by dingo rangers 
 
d. Which ears were tagged Right  
    Details: Two male and one unidentified. 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people respond appropriately to the incident? (Ranger to assess) Yes 
Comments when the fishermen noticed the dingo stealing the bait from their bucket they locked it 
away in the car. 
 

 
 

Detailed report of events: On the 4th March at approx 10:00 two fishermen on the beach outside Govi 
CZ were approached by three dingos. The dingos were coming within 1-2 meters proximity and showed 
no signs of aggression, fear or wariness. One of the dingos walked up to a bucket next to their car and 
stole a mullet. The fishermen quickly chased the dingos away and put the bucket in the car. An off duty 
dingo ranger travelling down the beach noticed the events and stopped and briefed them on dingo safety 
and food security.   

 

 

 

 

 

 

 

 

 

 

 

Additional comments and notes: The fishermen said the dingos went back up into the dunes and 
headed for their camp in Govi CZ. 

 

 

 

 

 

Action taken: The off duty ranger briefed the fishermen on dingo safety and food security. He also rang 
the Eurong dingo ranger who promptly went down and spoke to the fishermen. 
 
 
 

 

 

Proposed further action: Rangers notified of the incident. Interview conducted by a dingo ranger and 
report generated and circulated. 
 
 

 

 

Faxed/emailed date:  3/04/2013                                 Officers signature:  GM 
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Dingo Incident Report Form Insert Code: C Dingo ID: OOR12m (confirmed) 
 
Date (of incident): 20.03.2013 
Location (of incident): Taleebra Creek beach 

Time (of incident 24hrs): 1030-1045 
Reporting Officer/s signature:  
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

             

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance)              

  damaging property (specify)       

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance)       

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify) Ranger clapped hands at 

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   

Sub adults                   
Juvenile 1             

Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: OOR12m 
 
d. Which ears were tagged Left 
    Details: Ear flopped 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name - Fraser Island Discovery Tours 
Address:       
Phone #:   
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   commercial tour operator      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people respond appropriately to the incident? (Ranger to assess) No 
Comments       
 

 
 

Detailed report of events: On travelling northwards along the beach, myself and two other rangers 
observed a parked Fraser Island Discovery Tours bus adjacent to Taleebra Creek and with all 
passengers and the driver milling around the back of the bus eating morning tea. An esky was on the 
ground with its lid on, and we then noticed a dingo loitering within a couple of metres of the people and 
the esky. When the driver noticed us, he made an effort to shoo the dingo away. We pulled up and I 
spoke to the driver, He informed me that the dingo had been loitering around the group for 10-
15mins but wasn't being aggressive towards anyone. I told that it was in the dingo and the group's 
best interests for to actively discourage the dingo from loitering around them. suggested that 
the dingo approached as it had smelt a container of muffins which was stashed in the back of the bus. I 
clapped my hands against a clip board folder and this scared the dingo off to the dunes, where it then 
sat and continued to watch the group. The dingo was non-plussed by the presence of rangers. We 
departed and there is a chance that the dingo may have moved back towards the group after we left. 
 

 

 

 

 

 

 

 

 

 

 

Additional comments and notes: This dingo is observed regularly patrolling the beach between 
Eurong and Dilli Village. It is very habituated. 
 

 

 

 

 

Action taken: Attempted to scare dingo off, spoke to driver. 
 
 
 

 

 

Proposed further action: Monitor behaviour of dingo, appropriate driver and passenger reminder 
letters to be sent to all CTOs. 
 
 

 

 

Faxed/emailed date:  23.03.2013                                 Officers signature:KF 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the View Tab – then scroll down to Toolbar and 
select Forms. The Form toolbar will display – click the lock icon. You can now insert a picture using the Insert tab.   
 

         Photo 1. 
         Description (who took photo/when):
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

         Photo 2. 
         Description (who took photo/when): 
               

 

 

 

 

 

 

 

 

 

 

 

 

 

                               Photo 3. 
         Description (who took photo/when): 
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Dingo Incident Report Form Insert Code: C Dingo ID: PuWW12m & OOR12m 

 
Date (of incident): 16/04/2013 
Location (of incident): Eurong Beachfront 

Time (of incident 24hrs): 16:45 
Reporting Officer/s signature:  
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

             

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance)              

  damaging property (specify)       

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance)       

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify)       

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   

Sub adults                   
Juvenile 2             

Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: PuWW12m&OOR12m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people respond appropriately to the incident? (Ranger to assess) Yes 
Comments       
 

 
 

Detailed report of events: On the 16th April 2013, at approx 16:45, an off duty ranger was fishing on the 
beach opposite the QPWS Ranger base at Eurong. The ranger noticed the two dingos heading directly 
towards him from the south. When the two dingos were within close prioximity of him, one of the dingos 
(OOR12m) lay down on the beach while the other (PuWW12m) walked up to him in the water and 
proceeded to sniff the air and gesture towards the bait bag which was on the rangers shoulder. A 
number of cars saw the dingos and drove towards the ranger to see if he was alright. The two dingos 
then left when scared away. 
 

 

 

 

 

 

 

 

 

 

 

Additional comments and notes:       

 

 

 

 

 

Action taken: Report generated and circulated.  
 
 
 

 

 

Proposed further action:       
 
 

 

 

Faxed/emailed date:  18/14/2013                                 Officers signature:  GM 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the View Tab – then scroll down to Toolbar and 
select Forms. The Form toolbar will display – click the lock icon. You can now insert a picture using the Insert tab.   
 

         Photo 1. 
         Description (who took photo/when):
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

         Photo 2. 
         Description (who took photo/when):
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

         Photo 3. 
         Description (who took photo/when):
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Dingo Incident Report Form Insert Code: D  Dingo tag: OOR12m & 

Female not seen clearly 
 
Date (of incident): 23 April 2012 
Location (of incident): One Tree Rocks CZ and 
Beach 

Time (of incident 24hrs): 1500 
Reporting Officer/s: BS & JG 
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 

check/uncheck) 

 

B) Habituated. 

  not wary of humans 

  moving through common areas to humans  

  curious 

  loitering at recognized visitor sites (no humans 

       present) 

 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    

       nearby)      

  stealing food or property (specify)  

       Juice poppers / Fish 

  soliciting food 

  being fed or encouraged 

  living under or in infrastructure 

  following closely (distance)              

  damaging property (specify)       

  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 

  dominant/submissive testing 

  stalking 

  tent ripping (campers inside tent) 

  circling (distance) <2m 

  dominant towards humans 

  incorporate humans into pack behaviour 

  humans regarded as competitors for resources 

  bailing up/ambushing (walking alone or 

      unsupervised) 

  hunting tactics (with intent to test a response) 

  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 

  attacking 

  causing casualty 

  hunting tactics (intent to attack) 

  bailing up/ambushing (intent to attack) 

  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 

  when yelled at 

  when chased away 

  when yelled at and chased away 

  when person stopped moving/making a noise 

  other (specify)       

 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   

Sub adults                   
Juvenile 1             

Unknown Age       1       

 
c. Were the dingo(s) tagged Yes - all dingo(s)  
    Details: floppy eared male and similar sized 
female 
 
d. Which ears were tagged click to select 
    Details: Male left, female right 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Floppy tagged left ear male - OOR12m 
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name: John  
Address:       
Phone #:       
Age

Name: Brenton  
Address:       
Phone #:       
Age:
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people respond appropriately to the incident? (Ranger to assess) Yes 
Comments       
 

 
 

Detailed report of events:  
 
Rangers John and Brenton were driving along the beach when they saw a dingo take a freshly caught 
fish from a woman fishing. Shortly after, they were waved down by the woman just as another dingo 
arrived. She complained that the dingoes were getting too close to her and her 5yo grandson. John and 
Brenton then chased the dingoes away. The dingoes were not easy to move on. The female dingo kept 
circling back to the woman and her grandson but was eventually chased up the beach. OOR Male was 
chased to nearby One tree Rocks Camping zone where he took 2 drink "poppers" from a table at a 
camp. He then hid under a camping trailer but was chased away. 
John and Brenton went back to the woman and said the dingoes had been moved on but may return. 
She thanked them. The grandson was taken by his parents but the woman continued fishing.  

 

 

 

 

 

 

 

 

 

 

 

Additional comments and notes:       

 

 

 

 

 

Action taken: Dingoes actively discouraged by QPWS staff. Initial report taken by Andrew and passed 
on to dingo ranger waddy point. Supervisors notified 25.04.13. Report revised, generated and circulated  
 
 
 

 

 

Proposed further action: Increase patrols in this area - particularly morning and afternoon, monitor and 
identify dingoes in the area displaying this type of behaviour. 
 
 

 

 

Faxed/emailed date:  26.04.2013                                                        Officer:Anthony 
Dargusch 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the View Tab – then scroll down to Toolbar and 
select Forms. The Form toolbar will display – click the lock icon. You can now insert a picture using the Insert tab.   
 

         Photo 1. 
         Description (who took photo/when):
              
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

         Photo 2. 
         Description (who took photo/when): 
               

 

 

 

 

 

 

 

 

 

 

 

 

 

                               Photo 3. 
         Description (who took photo/when): 
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Dingo Incident Report Form Insert Code: E Dingo ID: OOR12m 
 
Date (of incident): 10 June 2013 
Location (of incident): Eurong beachfront 

Time (of incident 24hrs): 10.45 
Reporting Officer/s signature: L. Behrendorff 
Base: Eurong 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 
check/uncheck) 

 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Didn't leave area for another 

hour. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown

Adults                  
Sub adults                  
Juvenile 1             
Unknown Age                  

 
c. Were the dingo(s) tagged Yes 
    Details: OOR12m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: White chest and floppy ear 
 
Question 4: Details of person(s) involved in 
dingo incident. 
Name:
Address: C/ Eurong Beach Resort 
Phone #: 
Age:

Whiteness details. 
Name:
Address:
Phone #:

Name:
Address: Brisbane 
Phone #: 

Name:
Address: Second Valley Resident 
 
Name: (SV Resident) 
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Questionnaire:                  Specify visitor type   resort staff      

Did they receive an information pack with their permits click to select 
Did they read the Dingo BrochureUnknown 
Did the people respond appropriately to the incident? (Ranger to assess) click to select 
Comments Was walking on beach alone. Eurong staff receive dingo safety messages.  
 
 
 
Detailed report of events: At 10:53 from Eurong beach resort contacted myself to advise that a 
dingo attack had occurred on the beachfront involving a female resort staff member. had 
attempted to contact the QPWS duty managers and other QPWS office numbers without success. 
 

called my phone at 10:56 to report the same incident and was the First Responder in 
attending to the patient. 
 

was walking down the beach when a dingo approached her from behind. She turned around and 
saw the dingo then ran towards the water she subsequently tripped and fell in the shallow water. The 
dingo attacked her, biting her left bicep between her shoulder and elbow and would not let go.  
 

attempted to stand and return to the resort track. Witnesses observed staggering across the 
beach towards the track, screaming with the dingo hanging from her arm. 
 
Witnesses approached then attracted the assistance of who 
grabbed a stick to fend off the dingo still attached to her arm. The dingo let go and retreated to the bush 
but continued to pursue throughout the incident until was behind the resort gate. 
 
The incident was witnessed by various separate parties. 
 

a observed the incident from a distance with his
was near the entrance to Second Valley when they observed what they thought looked to be two 

children playing in the water until they heard screaming. They ran towards the screaming and got about 
two-thirds of the way there before observing on her hands and knees attempting to get up out of 
the water with a dingo attached to her arm.  As and his continued to run toward the incident two 
men in and a woman ran down from around the resort entrance and chased the dingo away. 

was nearly to the track (with the dingo still attached to her arm). 
 

then went back to second valley to inform (ambulance first responder). went to 
the resort area and saw the men in the and asked if the dingo still in the area was the dingo 
involved, they said it was. said it was a red and white tag in a floppy left ear. 
 
This dingo had been hanging around and his family while they were fishing the day prior to the 
incident. 
 

(Resort guest) " I was approached by a woman running towards me screaming 
"Help, help, dingo!". I saw a dingo had a on the left arm below the shoulder and above the 
elbow. Her arm was in full stretch as she was staggering up the beach to the resort. I grabbed a stick 
and ran towards the dog that let go and ran towards the bush. It [the dingo] continually tried to return and 
get at her from another angle. The girls from the resort arrived tending to the injured girl while I kept the 
dingo away.  
  
A passer by in a vehicle offered them a lift to the buildings but the girls refused the offer when they saw 
a baby in the back. The offer for using the tail-gate was also refused. The girls chose to lift and carry the 
injured girl about 150 yards to the building area. They asked me to stay and protect them from the dog 
that was still trying to get to the injured girl." 
 

stated that "the dingo stood it's ground at the gate and had it's mind set." He had also observed the 
dingo licking the blood from the sand. "The girl lost a lot of blood and it was also coming down her leg 
from beneath her clothes." stated that the girl was going into shock and her legs were giving out 
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on her as the other girls were tring to get her to the gate. 
 

saw a young woman walking toward the beach with a dingo following her; 
the woman did not seem to notice it was there. When she saw the dingo she started to cry and ran 
towards the water with the dingo following. As she got to the waters edge she fell over and the dingo bit 
her on the arm. The woman got to her feet with the dingo still on her arm. called to her husband 
and a friend and they ran toward the woman as they approached the dingo let go. They then took the 
woman beach toward the resort entrance. 
 
The dingo was tagged in its left ear and the ear was bent down. 
 
Eurong Resort staff in attendeance included and

(Manager) observed the dingo at the gate as the staff brought in. The dingo chewed 
on one of the girls shoes and hung around for about half an hour. 
 
 
Additional comments and notes: OOR12m is the more dominant of the 2012 Eurong litter. He has 
been involved in a recent code E incident and suspected code D incident. His tag has faded to red and 
white.This dingo has been fed and habituated from a young age by some visitors, locals and residents. 
 
STATEMENTS ATTACHED 
 

interviewed by L. Behrendorff & J. Kellaway. 
was interviewed by L. Behrendorff 11.24 am and later by J. Kellaway. 

interviewed by J. Kellaway. 
interviewed by L. Behrendorff 14.11. and voiced concerns 

regarding the WPHS protocols pertaining to the way the resort staff refused the lift when a dangerous 
dingo was still pursuing the injured girl. 

was advised by "a man" that this dingo was seen half an hour before the incident with a man who 
was playing tug-of-war with a coconut husk with it. 

was also involved in attempting to advise a group of people half an hour after the incident who 
were parked near OOR12m and getting a baby out of the car to view it. When approached the 
people and advised them of what had happened and to return the baby to the vehicle he was 
reprimanded by the mother. 
 
A Eurong Resort staff dingo safety talk was scheduled for this Thursday, and dangerous dingo signage 
was erected following the previous code E incident 1 June 2013.  
 
 
Action taken: SR, AM advised 11:40. Report generated. HD process instigated. 
 
 
 
Proposed further action: Discuss WPH&S process with Resort manager for dingo incident 
management regarding resort staff involvement. 
 
Continue education of all visitors and stakeholders against feeding and habituation of dingoes.  
 
Explore the option to approach media outlets for support regarding their publication of images portraying 
inappropriate dingo interactions that can influence visitor/stakeholder perception of safe behaviour 
around Fraser Island dingoes. As seen in recent media articles around the Fraser Coast and interstate. 
 
 
 
Faxed/emailed date:  11 June 2013                            Officers signature:  L. Behrendorff 
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Photos  
 
         Photo 1. 
         Description: Punctures and bruising 
         on left 

Photo 2. 
         Description (who took photo/when):
         Injury Left 

Photo 3. 
         OOR12m taken directly after incident 
         while waiting at the 
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ATTACHMENT 1. 
Statement from

Shortly before 11am I was approached by his and 
in Eurong’s second valley. His mobile phone number is:

They told me there had been a dingo attack in front of the Eurong Beach Resort. 
They said they were near the entrance to the second valley when they saw a dingo attacking who they 
thought was a child of about 10 or 11 years old. 
They said they ran towards the person, but by the time they were within about 100 metres other people had 
run out from the entrance to the resort valley and the dingo had run away. 
They said the person they thought looked like a child had been escorted towards the resort and the dingo had 
circled around and had been following them at a distance. 
I telephoned QPWS natural resources ranger Linda Behrendorff to make sure she was aware of the 
incident. She told me she was off the island and was trying to contact a ranger on the island. 
I contacted the island paramedic and asked if he had been dispatched. He hadn’t been. 

said the person attacked would need medical attention so I drove with to the Eurong Resort in 
the Ambulance first responder vehicle. I was contacted by the Fraser Island paramedic as I was leaving the 
second valley who told me he had been dispatched. He said he had been told it was a 29 year old female 
resort staff member. 
He said he would ask Ambulance Communications to dispatch me. I told him I was already on the way. 
When I arrived at the resort, the patient was sitting on some steps, and another staff member, was 
holding dressings on her left bicep. I placed on the stretcher in the first responder 
vehicle and tended to her. 
I inspected her injuries, recorded them and replaced the dressings. The bleeding had almost stopped. I 
administered methoxyflurane at 11.20am to reduce the pain. There was a puncture wound on the inside of 
her left bicep and a scratch mark. On the exterior of the left arm there was a deep wound about 5cm in 
diameter. There was flesh missing and the wound was between 1 and 2cm deep.  
I interviewed a witness who was touring the island with her family. She is: of 

She told me she had been on the side of the entrance road, outside the grid and near a sign (about 15 metres 
from the grid). 
She described the incident and said it would have been about 10.45am. 
She said she saw the young woman on the beach and watched as a dingo approached her. She said the 
woman appeared not to have seen the dingo at first. She said the woman turned around and seemed to panic 
and ran towards the water. The dingo chased her. She tripped and fell in the shallows and the dingo bit her 
on the left arm. She said the woman was screaming for help. 
The witness said she had nothing to use to beat the dingo with, so she called to her husband and a friend who 
ran down to the beach. 
She said the dingo held on while the woman struggled to her feet. She managed to get on to her feet and the 
dingo still held on. When they ran down to the woman the dingo released its grip and ran away. 
I interviewed the patient and she said she ran from the dingo towards the water. She said she fell and the 
dingo grabbed her in its jaws by the left arm above the elbow. She said the water wasn’t deep and her face 
didn’t go under water. 
She said the dingo held on while she struggled to her feet and didn’t let go until people started running 
towards her. 
The patient was transferred to the paramedic’s ambulance and she was transported across to Kingfisher Bay. 
A Hervey Bay crew was dispatched to catch the ferry to Kingfisher and transport her to the Hervey Bay 
Hospital. 
While I was tending to the patient the dingo approached the grid. identified the dingo as the 
one she saw attacking the patient. 
I asked and another man to see if they could see the dingo’s ear tag. They both said it was tagged 
in the left ear and that the ear was drooping. They said the colours were red and white. 
The dingo was hovering around on the beach for some time. There were people on the beach and the dingo 
was moving in among them. The man who helped identify the dingo went down to the beach to warn them. 
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He approached a woman standing holding a baby and told her the dingo had recently bitten a woman and 
told her it might be best to put the baby in the vehicle. The woman responded: “Mind your own business.” 
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Age tagged

# Base M/F Used Location Comments Age

245 Waddy Pt M
blue pink pink

4/02/2013

South Waddy 

Beach BPiPi12m

Juvenile

246 Waddy Pt M

red purple white

4/02/2013

Sth Waddy 

Beach Access 

Rd RPuW12m Juvenile

247 Eurong M purple green white 6/02/2013 Gabala CZ PuGW12m Juvenile

248 Eurong F
white red white

7/03/2013

Eurong fenceline 

nth

WRW11f M'chipped. Unknown female in this area, 

possibly from northern beach pack. Sub adult

249 Dundubara M green yellow purple 16/03/2013 Bowal Ck GYPu12m Juvenile

250 Eurong F green green red 22/03/2013 Coolooloi Creek GGR12f (estimated). Juvenile

251 Eurong M black black black 22/03/2013 Coolooloi CZ BlBlBl06m (estimated) . Old adult

252 Eurong F
blue blue blue

22/03/2013

Base of Lead 

Light BBB12f (estimated) Juvenile

253 Eurong M blue blue blue 23/03/2013 Gabala CZ BBB12m (estimated)  Juvenile

254 Eurong M pink yellow pink 24/03/2013 Winnam CZ PiYPi11m (estimated).  Sub adult

Dec date

Eurong M blue red red 29/02/2012

Nthn end of 

Cornwells CZ Deceased - Vehicle strike.

Juvenile 2/07/2012

Eurong M
orange orange red

31/10/2012

Eurong 

Beachfront, Sthn Deceased - Humane Destruction 

Juvenile

11/06/2013

Dundubara F pink red pink 10/05/2013 Dundubara CG Deceased  dingo attack Juvenile 17/05/2013

Eurong F OTR UT22F-2013 - Vehicle strike Juv 18/02/2013

Eurong M

200m sth 

Wongai cz UT12M-2013 - Dingo Attack Juv 7/04/2013

Eurong M Sth Eli Ck UT11M-2013 - Vehicle Strike Sub Adult 9/05/2013

Eurong M OTR UT12M-2013 - Vehicle Strike Juv 27/05/2013

Untagged

Untagged

Untagged

Untagged

Tag Pattern

Dingo Ear Tag Register, active list 25 Jan to 12 June 2013

Dingo Ear Tag Register,Deceased list 25 Jan to 12 June 2013
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